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RX72M グループ 
EtherCAT EoE サンプルプログラム 

要旨 
本書は、Renesas RX72M プラットフォームに適合した EtherCAT スタックコードを使用した EtherCAT®

スレーブ機能のサンプルプログラムのセットアップ手順について説明します。EtherCAT®マスター構成ツー

ルを使用してスレーブの動作とスタック機能を確認する手順について説明します。 
 
 
対象デバイス 
RX72M 
 

目次 

1. 概要 .................................................................................................................................. 3 
1.1 略語/定義 ...................................................................................................................................... 3 
1.2 参考資料 ........................................................................................................................................ 3 

2. 特徴 .................................................................................................................................. 4 

3. ソフトウェアの構成 ......................................................................................................... 5 

4. 動作環境 ........................................................................................................................... 6 
4.1 テスト環境 .................................................................................................................................... 6 
4.2 FIT モジュールの構成 ................................................................................................................... 6 
4.3 サポートプロジェクト .................................................................................................................. 6 

5. ボードの設定と接続 ......................................................................................................... 7 
5.1 RX72M 通信ボードのセットアップと接続 ................................................................................... 7 

5.1.1 RX72M 通信ボードの設定 ...................................................................................................... 7 
5.1.2 電源の選択 .............................................................................................................................. 8 
5.1.3 通信ボードの接続 ................................................................................................................... 8 

5.2 RSK ボードのセットアップと接続 .............................................................................................. 8 
5.2.1 Power supply selection ........................................................................................................ 8 
5.2.2 RSK ボードの接続 .................................................................................................................. 9 

5.3 CPU カードのセットアップと接続 ............................................................................................... 9 
5.3.1 CPU カードの設定 .................................................................................................................. 9 
5.3.2 電源の選択 .............................................................................................................................. 9 
5.3.3 CPU カードの接続 .................................................................................................................. 9 

5.4 スレーブスタックコードの生成 .................................................................................................. 10 

6. TwinCAT3 のセットアップ ............................................................................................ 13 
6.1 ESI ファイルの登録 ................................................................................................................... 13 
6.2 ドライバを追加 ........................................................................................................................... 13 



RX72M グループ EtherCAT EoE サンプルプログラム 

R01AN7520JJ0100  Rev.1.00  Page 2 of 29 
2024.10.15  

7. FIT モジュールのプロジェクト追加 ............................................................................... 14 

8. EtherCAT EoE サンプルプログラムの実行 ................................................................... 15 

9. EoE の評価 .................................................................................................................... 19 
9.1 IP アドレス設定 .......................................................................................................................... 19 
9.2 TwinCAT3 への接続 ................................................................................................................... 20 

9.2.1 I/O デバイスのスキャン ........................................................................................................ 20 
9.2.2 EEPROM データの更新 ....................................................................................................... 22 
9.2.3 EoE のための TwinCAT3 設定 ............................................................................................. 24 
9.2.4 エコーサーバでの動作確認 ................................................................................................... 26 

10. Appendix ....................................................................................................................... 27 
10.1 Appendix A : パッチのインストール方法 ................................................................................. 27 

改訂記録 ................................................................................................................................ 29 
 



RX72M グループ EtherCAT EoE サンプルプログラム 

R01AN7520JJ0100  Rev.1.00  Page 3 of 29 
2024.10.15  

1. 概要 
このドキュメントでは、Renesas RX72M プラットフォームと互換性のある EtherCAT スタックコードを使

用して EtherCAT の Ethernet over EtherCAT 機能をテストする手順について説明します。ドキュメントの

範囲は、SSC ツールを使用して EtherCAT スレーブ スタック コードを生成する方法と、TwinCAT マス

ターおよびテスト アプリケーションに対する動作をテストする方法の説明に限定されています 
 
EtherCAT (Ethernet for Control Automation Technology) は、Beckhoff Automation が開発した Ethernet 
ベースのフィールドバス システムです。EtherCAT の開発は、通信ジッタが少なく、ハードウェア コスト

を削減し、データ更新時間が短いオートメーション アプリケーション (モーション コントロール、I/O、セ

ンサーなど) に Ethernet を適用することでした。 
 
EtherCAT スレーブ スタック コードを生成するツール (SSC ツール) は、ETG メンバーに無料で提供され

ています。これは、ETG Web サイトからダウンロードできます。SSC ツールを使用すると、開発者のニー

ズに合わせてカスタマイズされたスタック、デバイス記述ファイル (ESI)、および個別のソースコード、 

ドキュメントを生成できます。 
 
 

1.1 略語/定義 

表 1.1 略語/定義 

Index Abbreviations 
/Definitions Description 

1 CoE CAN application protocol over EtherCAT 
2 EEPROM Electrically Erasable Programmable Read-Only Memory 
3 ESC EtherCAT Slave Controller 
4 ESI EtherCAT Slave Information 
5 FoE File Access Over EtherCAT 
6 I2C Inter-Integrated Circuit 
7 MB Mail Box 
8 PDO Process Data Object 
9 SSC Slave Stack Code 
10 EoE Ethernet Over EtherCAT  
 
 

1.2 参考資料 
EtherCAT に関する技術情報は ETG メンバーサイトから、RX72M に関する情報は Renesas から入手でき

ます。 
 
表 1.2 技術資料 

Index Technical Inputs 
1 R01UH0804xxxxx-rx72m 
2 REN_r20ut4391xxxxxx-rsk+rx72m-usermanual_MAT_20190731.pdf 
3 REN_r20ut4388xxxxxx-rsk+rx72m-qsg_MAT_20190731.pdf 
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2. 特徴 
SSC ツールによって生成される EtherCAT スレーブ スタック コードは、EtherCAT スレーブ コントロー

ラの機能を提供します。 
 

以下の機能が含まれます: 
 
 ESM (EtherCAT State Machine) 
 Mailbox protocols: 

- CoE (CAN application protocol over EtherCAT) 
 

 Synchronization Modes: 
- Free Run 
- Sync Manager Synchronization 
- DC Synchronization 
 

 Ethernet over EtherCAT Profile: 
- M3S-T4-Tiny 

 

 
 

EtherCAT is a registered trademark and patented technology, licensed by Beckhoff Automation GmbH, 
Germany. 
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3. ソフトウェアの構成 
表 3 にサンプルプログラムのソフトウェア構成を示します。 
サンプルプログラムは、EtherCAT サンプル部分と TCP/IP サンプル部分から構成されています。 
EoE は、EtherCAT 通信データに Ethernet 通信フレームをカプセル化することで、Ethernet ベースのサービ

スやプロトコルを利用できるようにします。 
通信データのカプセル化により、受信時に分割された Ethernet 通信フレームを組み立てて送信する際の

Ethernet 通信フレームの断片化は、SSC の EoE サービスとして実装されています。 
仮想 Ethernet ドライバは、通常の TCP/IP スタックの物理層上の Ethernet ドライバを置き換え、TCP/IP プ

ロトコルスタックと EoE サービス間で Ethernet 通信フレームを受け渡す役割を担っています。 
TCP/IP サンプルはエコーサーバの機能を持ち、受信した TCP または UDP パケットをエコーバックしま

す。 
EtherCAT サンプルは I/O コントローラの機能を持ち、RSK ボード上の LED や DIP SW でマスターからの

入出力制御を確認することができます。 
 
表 3 ソフトウェア構造 
Layer / Sample EtherCAT Sample TCP/IP Sample 

Application layer I/O Controller* TCP Echo Server* 

Protocol stack layer 
EtherCAT Slave Stack (SSC)**  M3S-T4-Tiny 
including EoE Service 

Wrapper to driver layer EtherCAT SSC port M3S-T4-Tiny Ethernet driver  
Driver layer EtherCAT Slave Controller driver Virtual Ethernet* 

 
*  ：  provided by sample project 
** ：  provided by Beckhoff, patched by sample project 
       unmarked: provided by FIT 
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4. 動作環境 
本書で説明しているサンプルプログラムは以下の環境で動作します。 

 

4.1 テスト環境 
 

表 4.1 動作環境 

Supported MCU RX72M Group 
Evaluation board Renesas Starter Kit+ for RX72M (product type name: RTK5572MNxCxxxxxBJ) 

RX72M evaluation board TS-RX72M-COM from Tessera Technology 
RX72M CPU Card with RDC-IC 

Integrated development 
environment (IDE) 

e2 studio 2024-07 from Renesas Electronics 

Cross tool C/C++ Compiler Package for RX Family V3.06.00 from Renesas Electronics 
Emulator GCC for Renesas RX 8.3.0.202405 
 

 

4.2 FIT モジュールの構成 

このアプリケーションノートで説明するサンプルプログラムは、以下の FIT モジュールを使用して構成され

ています。 

表 4.2  FIT モジュール構成 

Type Module Name FIT Module Name Rev. 
Board Support 
Package 

Board support package (BSP) r_bsp 7.50 

Device Driver Compare-match timer (CMT) r_cmt_rx 5.60 
Middleware M3S-T4-Tiny r_t4_rx 2.10 
Device Driver EtherCAT r_ecat_rx 1.31 
 
 

4.3 サポートプロジェクト 
このアプリケーションノートでサポートするプロジェクトを以下に示します。 
 
表 4.3  プロジェクトリスト 

MCU Evaluation Board Name Project Name 
RX72M RSK board ecat_eoe_demo_comrx72m 

Communications board ecat_eoe_demo_cpurx72m 
CPU card ecat_eoe_demo_rskrx72m 

 
 
以下のセクションでは、RX72M 通信ボード プロジェクトを例として使用します。RSK ボードまたは CPU 
カードプロジェクトを使用している場合は、必要に応じて RX72M 通信ボードのステートメントを変更して

ください。 
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5. ボードの設定と接続 
5.1 RX72M 通信ボードのセットアップと接続 
評価ボードの詳細については、「RX72M 通信ボード ハードウェアマニュアル」を参照してください。 

 

図 5.1  RX72M Communication board configuration 

 
 

5.1.1 RX72M 通信ボードの設定 
評価ボードの電源を入れる前に、ジャンパー設定を行い、各ケーブルを接続します。 
JTAG のコンフィギュレーションモードを設定します。通常はジャンパーピンの 2-3 ショートで使用しま

す。ホットプラグイン機能を使用するには、1-2 ショートに変更して使用します。 
各部品の位置については[RX72M 通信ボードハードウェアマニュアル]を参照してください。 

 

図 5.2 Jumper pin setting 
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5.1.2 電源の選択 
このボードは、DC Jack または USB から DC 5 V を入力することで RX72M に電源を供給できます。  
どちらかを選択してください. 

 

5.1.3 通信ボードの接続 
各ケーブルを次のように接続します。 
(1) イーサネットケーブル (カテゴリ 5 以上を推奨) を Ether ポート(CN 2 IN) に接続します。 
(2) ICE の JTAG コネクタを JTAG コネクタ、ホスト コンピュータとの USB 接続に接続します。 
(3) DC ジャックまたは USB から DC 5 V を接続し、電源を入れます。 

 
 

5.2 RSK ボードのセットアップと接続 
評価ボードの詳細については、「Renesas Starter Kit + for RX72M ユーザーズマニュアル」を参照してくだ

さい。(REN_r20ut4391jg0100-rsk+rx72m-usermanual_MAT_20190731.pdf) 

 

図 5.3  RX72M RSK board configuration 

 
5.2.1 Power supply selection 
このボードは、DC ジャックで DC5V を入力することにより、RX72M に電力を供給できます。 
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5.2.2 RSK ボードの接続  
各ケーブルを次のように接続します。 
(1) イーサネット ケーブル (カテゴリ 5 以上を推奨) を Ether ポート(ETHERNET0) に接続します。 
(2) ICE の JTAG コネクタを JTAG コネクタに接続し、ホストコンピュータと USB 接続します。 
(3) DC ジャックから DC 5 V を接続し、電源を入れます。 

 

5.3 CPU カードのセットアップと接続  
本ボードの詳細については、「RX72M RDC-IC 付き CPU カード ユーザーズマニュアル」

(R12UZ0098EJ0100)を参照してください。 

 

図 5.4  RX72M CPU Card configuration 

 
 

5.3.1 CPU カードの設定 
CPU カードの電源を入れる前に、ジャンパーピンを設定してください。 

E2OB の使用    ：デバッガー切り替えジャンパー ピンをショートします。 
デバイス ID の設定  ：ID に従ってジャンパー ピン(JP2、3)を取り付けます。ショートするとビット 

"1" に相当します。 

5.3.2 電源の選択 
CPU カードには DC ジャックがなく、USB コネクタから DC5V を入力します. 

 
5.3.3 CPU カードの接続 
各ケーブルを次のように接続します。 
(1) イーサネット ケーブル (カテゴリ 5 以上を推奨) を Ether ポート(CN8 IN)に接続します。 
(2) エミュレータと電源の共通 USB コネクタをホストコンピュータに接続します。 
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5.4 スレーブスタックコードの生成 
SSC ツールは、スレーブスタックコードの生成に使用されます。 
注)、以下の説明文のフォルダ名は、使用するツールに合わせて置き換えてください。 

 
1. Windows の[スタート]メニューから SSC ツールを起動します。 

 
 
 

2. [ファイル] > [開く] を選択します。 

 
 
 

3. 次のファイルを選択してダブルクリックします。 
“FITDemos¥ecat_eoe_demo_xxxrx72m¥utilities¥ssc_config¥ RX72M EtherCAT EoE.esp” 
 
注). xxx は “com”、“rsk” 、“cpu.”のいずれかです。 

 
 

4. クリックすると、次のウィンドウが開きます。 
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1. [Project] → [Create new Slave Files] を選択します。 

 

 
 

2. [Start]ボタンをクリックすると、EtherCAT スレーブスタックコードの作成が開始されます。 

 
 
 

3. 「New file created successfully」と表示されたら、作成処理は完了しており、ソースファイルは以下の  
フォルダに配置されています。 
“FITDemos¥ecat_eoe_demo_xxxrx72m¥utilities¥ssc_config¥ssc_config” 
 

注). xxx は “com”、“rsk” 、“cpu.”のいずれかです。 
 

 
 

注), 生成中にエラーが発生する場合は、SSC ツールの [[Tool] -> [Option] -> [Create Files] で「Create 
device description」のチェックを外してください。  
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4. apply_patch.bat ファイルを右クリックし、[Run as an administrator]→[Yes を選択します。                            

パッチファイルには、SSC ソースファイルを RX72M に最適化のための変更が含まれています。 
“FITDemos¥ecat_eoe_demo_xxxrx72m¥utilities¥patch¥apply_patch.bat” 
 
注). xxx は “com”、“rsk” 、“cpu.”のいずれかです。 

 

 
パッチの実行後、変更されたソースファイルは次のフォルダに保存されます。 

 
“FITDemos¥ecat_eoe_demo_xxxrx72m¥project¥src¥application¥ecat¥beckhoff” 

 
 

注). パッチコマンドが PC にインストールされていない場合は、patch をインストールする必要があ 
ります。(Appendix A を参照) 
すでにインストールされている場合は、この手順をスキップしてください。 

 
注). xxx は “com”、“rsk” 、“cpu.”のいずれかです。 
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6. TwinCAT3 のセットアップ 
6.1 ESI ファイルの登録 

TwinCAT を起動する前に、リリースフォルダに含まれている ESI ファイルを TwinCAT のフォルダにコ

ピーしてください  
“¥TwinCAT¥3.x¥Config¥IO¥EtherCAT” 
 
現在のリリースの ESI ファイルは、以下から入手します。 
“FITDemos¥ecat_eoe_demo_xxxrx72m¥utilities¥esi¥ESI¥RX72M EtherCAT EoE.xml” 
 

注). xxx は “com”、“rsk” 、“cpu.”のいずれかです。 
 
 

6.2 ドライバを追加  
TwinCAT の Ether ドライバを追加します。(初回のみ) 
スタートメニューから[TwinCAT 3]→[Show Realtime Ethernet Compatible Devise]を選択します。 
 
通信ポートから接続された Ether ポートを選択してインストールします。 

 
 

注). PC にインストールされているネットワーク カードによっては、 
「Installed and ready to use device (realtime capable)」ではなく、 
「Installed and ready to use device (for demo use only)」になる場合があります。  
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7. FIT モジュールのプロジェクト追加 
EtherCAT FIT モジュールを e2 studio に追加することで、Smart Configurator で使用できます。 
手動で追加する方法は次のとおりです。 
e2 studio の FIT モジュールが保存されているフォルダに EtherCAT FIT モジュールをコピーします。 
 
e2 studio で FIT モジュールの場所を確認してください。 
[Window]→[Preferences]→The Preferences window opens.  
[Renesas] →[Module Download]→[Location (RX)] 

 
「ロケーション(RX):」は、e2 studio の FIT モジュールが保存されているフォルダです。 

 
 
 

EtherCAT FIT モジュールは、サンプルプログラムの FITModules フォルダに格納されています。 
“r01an7520xx0100-rx72m-ecat-eoe¥FITModules”フォルダ内のファイルを FIT モジュールが保存されてい

る場所にコピーします。 
r_ecat_rx_vN.NN.xml 

 
r_ecat_rx_vN.NN.zip 

 
r_ecat_rx_vN.NN_extend.mdf 

 
N.NN は 、バージョンを表す数値です。 
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8. EtherCAT EoE サンプルプログラムの実行  
この章では、Modbus サンプル アプリケーションとの通信手順について説明します。 
ツールのインストールとハードウェアの接続を完了するには、4 章「動作環境」と 5 章「ボードの設定と接

続」を事前に参照してください。 
 

1. e2studio を起動した後、サンプルプロジェクトをインポートします。  
File → Import → Existing Projects into Workspace.  
ルートディレクトリの選択をクリックし、「01an7520xx0100-rx72m-ecat-eoe¥FITDemos 
¥ecat_eoe_demo_xxxrx72m」フォルダを選択します。 

 
注). xxx は “com”、“rsk” 、“cpu.”のいずれかです。 

 

 
 
 

2. 「ecat_eoe_demo_xxxrx72m」プロジェクトの「ecat_eoe_demo_xxxrx72m.scfg」を開きます。t 
 

注). xxx は “com”、“rsk” 、“cpu.”のいずれかです。 
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3. コンポーネントタブを開きます。 

すべてのコンポーネントが有効になっていることを確認してから、コード生成を実行します。 

  
 
 

4. ビルドを実行します。 
このとき、ビルドエラーがないことを確認します。 

 
 
 
注). ビルド時にビルドエラーが発生した時は、以下を修正してください。 
 

Error:  

 

 

変更するコードの場所： 
“ecat_eoe_demo_xxxrx72m¥src¥smc_gen¥r_con fig¥r_bsp_config.h” 
 
#define BSP_CFG_EXPANSION_RAM_ENABLE  (0) →  (1) 
 
 
注). コンポーネント依存関係でエラーが出ますが、問題はありません。 
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5. アプリケーションをダウンロードしてデバッガーを実行する。 

ボードと J-Link を接続したら、  以下の手順でデバッグを開始します. 
Project Explorer view で、デバッグするプロジェクトのノードを右クリックし、 
[Debug As] → [Debug Configurations] を選択します。 

   
 
 

6. プログラムのダウンロード 
[Renesas GDB Hardware Debugging] → [ecat_eoe_demo_comrx72m]を選択し、デバッグをクリッ

クします。 
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 次のダイアログが表示されますので、デバッグ画面に切り替えます。 

  
 
 

7. プログラムがスタートします。 
[再開]ボタンをクリックします。 
デバッグが開始されると、プログラムは main.c で中断されます。 
もう一度 [再開] ボタンをクリックしてプログラムを実行します。 
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9. EoE の評価 
この章では、評価ツールを使用してサンプルプログラムを評価する手順について説明します. 

9.1 IP アドレス設定 
EoE サンプルプログラムを動作させるためには、EtherCAT マスターと EtherCAT スレーブの IP アドレスを

固定 IP アドレスに設定する必要があります。 
また、サンプルプログラムの TCP/IP スタックのネットワーク設定ファイルに EtherCAT スレーブの IP アド

レスを同時に設定してください。 
 

1. 下図のようにネットワーク接続設定でEtherCATとTCP/IPを有効にします。 

  
 
 

2. ホスト PC のネットワーク接続を下図のように構成します。 

  
 
 

3. IP アドレス等を変更する場合は FIT T4 の設定で変更してください 
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9.2 TwinCAT3 への接続 
以下の手順で TwinCAT3 を起動します。 
スタートメニューから[Beckhoff]→[TwinCAT3]→[TwinCAT XAE]を選択します。 

 
プログラムを起動したら、[File] → [New] → [Project] を選択して、TwinCAT XAE プロジェクトタイプの

新しいプロジェクトを作成します。その後の手順は以下に記載されています。 
 

9.2.1 I/O デバイスのスキャン 
1. [Solution explorer] → [ I/O] → [Device]で、下の図のように[Scan]を選択します。 

  
 
 

2. EtherCAT ポートは以下のように表示されます。OKを選択して押します。 

 
 

注). ネットワーク内に有効なスレーブが存在する場合、TwinCAT はチェックボックスとともに候補を表示 
します。 
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3. デバイスのスキャンを開始します。 

 
 
 
4. 図に示すように、検出されたデバイスが「Box1 (PFFFFFFFF)」の場合、ESI ファイルはダウンロード

されていないため、フリーランなしで続行します。 
検出されたデバイスに「Box1 (Renesas EtherCAT xxxx)」のような希望のESIファイル名が表示されて

いる場合は、フリーランを選択します。 
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9.2.2 EEPROM データの更新 
すでに他のアプリケーションのデータが EEPROM に書き込まれている場合は、データを置き換えます。 
EEPROM 上のデータを置き換える手順は次の通りです。 
 
1. [Box 1] をダブルクリックして、ウィンドウの右側にパネルを表示します。 

 
2. [EtherCAT] タブを選択します。 

 
3. [Advanced Setting] ボタンをクリックします。 

 
 

 
4. [ESC Access]→[EEPROM]→[Hex Editor]を選択 
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5. [Download from List]] → ESI ファイルを選択 [ESC Access] → [EEPROM] → [Hex Editor] から 

ESI ファイルを選択 
“FITDemos¥ecat_eoe_demo_xxxrx72m¥utilities¥esi¥ RX72M EtherCAT EoE.xml” 

 
 

6. OK してダウンロードします。 

 
 

 
7. ESI ファイル設定を適用します。  

デバイスを選択して削除します。 
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8. デバイスを再度スキャンします.           

目的の ESI ファイルが表示されていれば正常です。 

 
 

 
9.2.3 EoE のための TwinCAT3 設定 
EOE 操作用に TwinCAT3 を設定します。 

 
1. [Device]をダブルクリックし、[EtherCAT tab] → [Advanced Settings]ボタンをクリックします。  

 

 
 

2. [EoE Support] → [Virtual Ethernet Switch Enable] および [Connect TCP/IP Stack] を有効にします。 
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3. スレーブ情報を設定します。               

[Renesas EtherCAT RZ/N2 EoE]をダブルクリックし、[EtherCAT tab] → [Advanced Settings]を選択し

ます。 

 

 
 

4. [Mailbox] → [EoE]  を選択します。         

IP ポートを選択し、以下のように設定します。       
 IP Address: 192.168.10.100         
 Subnet Mask: 255.255.255.0        
 Default Gateway: 192.168.10.1 
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5. TCP/IP の動作を確認します。コマンドプロンプトを起動し、”ping 192.168.10.100” を実行します。

応答があれば接続は完了です。 

 

 
 

9.2.4 エコーサーバでの動作確認 
TCP エコーサーバの動作確認.  
SockV を起動 
ソケットタイプを選択→[TCPClient] にて以下の設定を入力     

Host IP: 192.168.10.100          
Host Port: Enter 1024           

[Create]ボタンをクリックします。コンソールの下に TCP クライアントソケットが表示されます。 
 

送信指示コンソールを開きます。 
[Communication]を選択、[send instruction dialog]にチェックを入れ、送信指示ウィンドウを開きます。  
メインウィンドウ（上部）にテキストを入力し、送信指示ウィンドウの 1 行送信ボタンをクリックすると、

入力したテキストと同じテキストがサブウィンドウ（下部）に表示されます。 

  

 
 
 

1 2 
3 
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10. Appendix 

10.1 Appendix A : パッチのインストール方法  
この章では、MinGW パッチをインストールする方法について説明します。 

 
1. 以下の URL より“mingw-get-setup.exe” をダウンロード。 

 
https://osdn.net/projects/mingw/downloads/68260/mingw-get-setup.exe/ 

 
 

2. “mingw-get-setup.exe”を実行し、ダイアログに従って”Mingw-installation-manager”をインストールして

ください。 
 
 

3. “Mingw-installation-manager”ウィンドウが表示されたら、左側のウィンドウで「基本セットアップ」を

選択し、右側のウィンドウで「msys-base-bin」を右クリックして「インストール用にマーク」を選択

します。 

  

 
 

4. 左側のウィンドウで「すべてのパッケージ」を選択し、右側のウィンドウで「msys-patch-bin」を右ク

リックして、「インストール用にマーク」を選択します。 

  

 

https://osdn.net/projects/mingw/downloads/68260/mingw-get-setup.exe/
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5. 上のメニューバーの「インストール」で「変更の適用」を選択します。 

  
 
 

6. 「Schedule of Pending Actions」ウィンドウが表示されたら、「Apply」ボタンをクリックします。 
 
 

7. 「All changes were applied successfully; you may now clone this dialogue」と表示されたら、patch.exe 
のインストールは成功です。 

 
 

8. インストールした patch.exe へのパスをシステム環境変数に登録します。登録後、PC を再起動しま

す。 
 
 

9. コマンドプロンプトを起動し、「where patch」と入力します。 
インストールした patch.exe へのパスが表示されれば問題ありません。 
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製品ご使用上の注意事項 
ここでは、マイコン製品全体に適用する「使用上の注意事項」について説明します。個別の使用上の注意事項については、本ドキュメントおよびテク

ニカルアップデートを参照してください。 

1. 静電気対策 

CMOS 製品の取り扱いの際は静電気防止を心がけてください。CMOS 製品は強い静電気によってゲート絶縁破壊を生じることがあります。運搬や保

存の際には、当社が出荷梱包に使用している導電性のトレーやマガジンケース、導電性の緩衝材、金属ケースなどを利用し、組み立て工程にはアー

スを施してください。プラスチック板上に放置したり、端子を触ったりしないでください。また、CMOS 製品を実装したボードについても同様の扱

いをしてください。 

2. 電源投入時の処置 

電源投入時は、製品の状態は不定です。電源投入時には、LSI の内部回路の状態は不確定であり、レジスタの設定や各端子の状態は不定です。外部

リセット端子でリセットする製品の場合、電源投入からリセットが有効になるまでの期間、端子の状態は保証できません。同様に、内蔵パワーオン

リセット機能を使用してリセットする製品の場合、電源投入からリセットのかかる一定電圧に達するまでの期間、端子の状態は保証できません。 

3. 電源オフ時における入力信号 

当該製品の電源がオフ状態のときに、入力信号や入出力プルアップ電源を入れないでください。入力信号や入出力プルアップ電源からの電流注入に

より、誤動作を引き起こしたり、異常電流が流れ内部素子を劣化させたりする場合があります。資料中に「電源オフ時における入力信号」について

の記載のある製品は、その内容を守ってください。 

4. 未使用端子の処理 

未使用端子は、「未使用端子の処理」に従って処理してください。CMOS 製品の入力端子のインピーダンスは、一般に、ハイインピーダンスとなっ

ています。未使用端子を開放状態で動作させると、誘導現象により、LSI 周辺のノイズが印加され、LSI 内部で貫通電流が流れたり、入力信号と認識

されて誤動作を起こす恐れがあります。 

5. クロックについて 

リセット時は、クロックが安定した後、リセットを解除してください。プログラム実行中のクロック切り替え時は、切り替え先クロックが安定した

後に切り替えてください。リセット時、外部発振子（または外部発振回路）を用いたクロックで動作を開始するシステムでは、クロックが十分安定

した後、リセットを解除してください。また、プログラムの途中で外部発振子（または外部発振回路）を用いたクロックに切り替える場合は、切り

替え先のクロックが十分安定してから切り替えてください。 

6. 入力端子の印加波形 

入力ノイズや反射波による波形歪みは誤動作の原因になりますので注意してください。CMOS 製品の入力がノイズなどに起因して、VIL（Max.）か

ら VIH（Min.）までの領域にとどまるような場合は、誤動作を引き起こす恐れがあります。入力レベルが固定の場合はもちろん、VIL（Max.）から VIH

（Min.）までの領域を通過する遷移期間中にチャタリングノイズなどが入らないように使用してください。 

7. リザーブアドレス（予約領域）のアクセス禁止 

リザーブアドレス（予約領域）のアクセスを禁止します。アドレス領域には、将来の拡張機能用に割り付けられている リザーブアドレス（予約領

域）があります。これらのアドレスをアクセスしたときの動作については、保証できませんので、アクセスしないようにしてください。 

8. 製品間の相違について 

型名の異なる製品に変更する場合は、製品型名ごとにシステム評価試験を実施してください。同じグループのマイコンでも型名が違うと、フラッ

シュメモリ、レイアウトパターンの相違などにより、電気的特性の範囲で、特性値、動作マージン、ノイズ耐量、ノイズ幅射量などが異なる場合が

あります。型名が違う製品に変更する場合は、個々の製品ごとにシステム評価試験を実施してください。 
 
 
 
 
・Arm® and Cortex® are registered trademarks of Arm Limited (or its subsidiaries) in the EU and/or elsewhere.  

All rights reserved.  
・Ethernet is a registered trademark of Fuji Xerox Co., Ltd. 
・IEEE is a registered trademark of the Institute of Electrical and Electronics Engineers Inc  

・EtherCAT® and TwinCAT® are registered trademark and patented technology, licensed by Beckhoff Automation 
GmbH, Germany. 
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ご注意書き 
1. 本資料に記載された回路、ソフトウェアおよびこれらに関連する情報は、半導体製品の動作例、応用例を説明するものです。お客様の機器・システ

ムの設計において、回路、ソフトウェアおよびこれらに関連する情報を使用する場合には、お客様の責任において行ってください。これらの使用に

起因して生じた損害（お客様または第三者いずれに生じた損害も含みます。以下同じです。）に関し、当社は、一切その責任を負いません。 
2. 当社製品、本資料に記載された製品デ－タ、図、表、プログラム、アルゴリズム、応用回路例等の情報の使用に起因して発生した第三者の特許権、

著作権その他の知的財産権に対する侵害またはこれらに関する紛争について、当社は、何らの保証を行うものではなく、また責任を負うものではあ

りません。 
3. 当社は、本資料に基づき当社または第三者の特許権、著作権その他の知的財産権を何ら許諾するものではありません。 
4. 当社製品を、全部または一部を問わず、改造、改変、複製、リバースエンジニアリング、その他、不適切に使用しないでください。かかる改造、改

変、複製、リバースエンジニアリング等により生じた損害に関し、当社は、一切その責任を負いません。 
5. 当社は、当社製品の品質水準を「標準水準」および「高品質水準」に分類しており、各品質水準は、以下に示す用途に製品が使用されることを意図

しております。 
 標準水準： コンピュータ、OA 機器、通信機器、計測機器、AV 機器、家電、工作機械、パーソナル機器、産業用ロボット等 
 高品質水準： 輸送機器（自動車、電車、船舶等）、交通制御（信号）、大規模通信機器、金融端末基幹システム、各種安全制御装置等 
当社製品は、データシート等により高信頼性、Harsh environment 向け製品と定義しているものを除き、直接生命・身体に危害を及ぼす可能性のあ

る機器・システム（生命維持装置、人体に埋め込み使用するもの等）、もしくは多大な物的損害を発生させるおそれのある機器・システム（宇宙機

器と、海底中継器、原子力制御システム、航空機制御システム、プラント基幹システム、軍事機器等）に使用されることを意図しておらず、これら

の用途に使用することは想定していません。たとえ、当社が想定していない用途に当社製品を使用したことにより損害が生じても、当社は一切その

責任を負いません。 
6. 当社製品をご使用の際は、最新の製品情報（データシート、ユーザーズマニュアル、アプリケーションノート、信頼性ハンドブックに記載の「半導

体デバイスの使用上の一般的な注意事項」等）をご確認の上、当社が指定する最大定格、動作電源電圧範囲、放熱特性、実装条件その他指定条件の

範囲内でご使用ください。指定条件の範囲を超えて当社製品をご使用された場合の故障、誤動作の不具合および事故につきましては、当社は、一切

その責任を負いません。 
7. 当社は、当社製品の品質および信頼性の向上に努めていますが、半導体製品はある確率で故障が発生したり、使用条件によっては誤動作したりする

場合があります。また、当社製品は、データシート等において高信頼性、Harsh environment 向け製品と定義しているものを除き、耐放射線設計を

行っておりません。仮に当社製品の故障または誤動作が生じた場合であっても、人身事故、火災事故その他社会的損害等を生じさせないよう、お客

様の責任において、冗長設計、延焼対策設計、誤動作防止設計等の安全設計およびエージング処理等、お客様の機器・システムとしての出荷保証を

行ってください。特に、マイコンソフトウェアは、単独での検証は困難なため、お客様の機器・システムとしての安全検証をお客様の責任で行って

ください。 
8. 当社製品の環境適合性等の詳細につきましては、製品個別に必ず当社営業窓口までお問合せください。ご使用に際しては、特定の物質の含有・使用

を規制する RoHS 指令等、適用される環境関連法令を十分調査のうえ、かかる法令に適合するようご使用ください。かかる法令を遵守しないことに

より生じた損害に関して、当社は、一切その責任を負いません。 
9. 当社製品および技術を国内外の法令および規則により製造・使用・販売を禁止されている機器・システムに使用することはできません。当社製品お

よび技術を輸出、販売または移転等する場合は、「外国為替及び外国貿易法」その他日本国および適用される外国の輸出管理関連法規を遵守し、そ

れらの定めるところに従い必要な手続きを行ってください。 
10. お客様が当社製品を第三者に転売等される場合には、事前に当該第三者に対して、本ご注意書き記載の諸条件を通知する責任を負うものといたしま

す。 
11. 本資料の全部または一部を当社の文書による事前の承諾を得ることなく転載または複製することを禁じます。 
12. 本資料に記載されている内容または当社製品についてご不明な点がございましたら、当社の営業担当者までお問合せください。 
注 1. 本資料において使用されている「当社」とは、ルネサス エレクトロニクス株式会社およびルネサス エレクトロニクス株式会社が直接的、間接的

に支配する会社をいいます。 
注 2. 本資料において使用されている「当社製品」とは、注 1 において定義された当社の開発、製造製品をいいます。 
 

(Rev.4.0-1  2017.11) 
 

本社所在地  お問合せ窓口 
〒135-0061 東京都江東区豊洲3-2-24（豊洲フォレシア） 

www.renesas.com 

 弊社の製品や技術、ドキュメントの最新情報、最寄の営業お問合せ窓

口に関する情報などは、弊社ウェブサイトをご覧ください。 

www.renesas.com/contact/ 

商標について   
ルネサスおよびルネサスロゴはルネサス エレクトロニクス株式会社の

商標です。すべての商標および登録商標は、それぞれの所有者に帰属

します。 
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